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Creating Searches in Morningstar Direct™™

M Overview

What do you do in Morningstar Direct™ when you need to create a set of securities
with certain characteristics, such as funds belonging to a specific Morningstar
category, or those with an expense ratio below a particular threshold, or stocks in an

industry that also have a P/E ratio below a certain number?

The Search function in Morningstar Direct is the solution to this problem. The Search
by Criteria window returns a set of investments currently matching whatever criteria
you define.

= Note: Prior to using this training guide, you should be familiar with the content in the Quick
Start Guide for Morningstar Direct. Also, this guide builds on the exercises offered in
Working with Investment Lists in Morningstar Direct.
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Creating Searches in Morningstar Direct™ How do searches differ in various parts of Morningstar Direct?

What is the difference between a
Search Criteria and an
Investment List?

If a search returns a set of investments, and a list is also a set of investments in
Morningstar Direct, then what is the difference between the two approaches?

A search offers dynamic results each time it is run. For example, if you search for
five-star, open-end funds in the Large Value category, you might find 145 funds today,
but the specific funds you see could (and likely will) change from month to month
(because the Morningstar Rating is updated monthly).

An investment list, however, is static and the items on a list do not change unless you
manually add or remove members to/from the list. In other words, you could save the
145 five-star Large Value funds from your search results to a list, and that list will not
change unless you add items to it, or remove items from it. To learn more about
creating lists, see Working with Investment Lists in Morningstar Direct.

How do searches differ in various
parts of Morningstar Direct?

You can create searches (or retrieve saved searches) from the following modulesin
Morningstar Direct:

» Local Databases

» Global Databases

» Performance Reporting
» Portfolio Management
» Portfolio Analysis, and
» Workspace.

Merningstar Direct

File MNew Favorites Tools Help Search for In This View

Home

Equity/Credit Research EAc:tiun' New ™ ﬂExpur‘tv [E] FDF @R

Local Databases r Name

Global Databases
Performance Reporting M Europe Large-Cap Value Equity

Asset Allocation

Portfolic Management

Portfolio Analysis

Markets

Asset Flows

Presentation Studio
Risk Model Analysis
I Workspace I

&5 Investment Lists

The highlighted modules
indicate areas in
Morningstar Direct
where you can create

or retrieve a search

» B2 My Lists
~E8 Search Criteria
E My Search Criteria

» B3 Report Templates

E Chart Templates
b B8 Data Sets
» B Custom Database

E Defined Contribution Plans

E Saved Reports

E Note Manager

E Retirement Plans
¥ B8 Group Manager

Which part of Morningstar Direct you create a search from depends, in part, on what
you need to search for in order to complete a task. For example, if you need to search
among only one type of investment, such as open-end funds for sale in your country,
you can create that search from the Local Databases module.
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Creating Searches in Morningstar Direct™ How do searches differ in various parts of Morningstar Direct?

However, if you need to create a search that considers both open-end funds and
exchange-traded funds, you could go to the Workspace or Performance Reporting
module to complete that search.

Finally, if your ultimate goal is not simply to generate a set of results from a search, but
to analyse the results, you would create the search from the Performance
Reporting module.

In the exercises that follow, you will see examples of the advantages and possible
limitations of a search created in each area of Morningstar Direct.
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Working with Simple Searches Overview

Working with Simple Searches

In a sense, all searches are created equal. No matter how many criteria you select or Overview

how they are ordered in the Search by Criteria window, each search requires you to do
the following:

» Select a field name (i.e., a data point) to evaluate
» Choose an operator (=, <, >, etc.) for the field's value, and
» Assign a value to the field; this could be a number or a text label.

For example, a very basic search to find funds in the Europe Large-Cap Value Equity
funds would use the following criteria (with the Europe/Africa/Asia market
classification):

Field Name Operator Value

Morningstar Category = Europe Large-Cap Value
Equity

A search to find funds whose ongoing charge is less than or equal to 1.25% would
look use the following criteria:

Field Name Operator Value

KIID Ongoing Charge <= 1.25

In this section, you will practice creating some relatively simple searches, and learn
how to save and retrieve the searches you create as well.

In a word, no. While you can use the Search by Criteria window to look for items by Should | create a search to look
name or ISIN code when you know those values, this action takes an extraordinarily for investments by name or ISIN
long time to complete. The number of clicks involved is not worth the effort. code?

Instead, create a list of known investments from the Workspace module. For details on
how to create lists, please see the Working with Investment Lists in Morningstar Direct
document.
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Working with Simple Searches Exercise 1: Create a search from the Local Databases module

When you create a search from the Local Databases module, you are effectively Exercise 1. Create a search

building on a search that already exists. For example, for users in the United Kingdom, ~ rom the Local Databases
when the Open-End Funds page is selected in the Local Databases module and you module

click the United Kingdom Open-End Funds (AFS) link (see screen shot after step 2

below), you are viewing a search result screening for open-end share classes for sale

in the United Kingdom.

In this first exercise, you will look for Europe Large-Cap Value Equity funds. Do the
following:

1. From the left-hand navigation pane, select the Local Databases module.
2. Click the Open-End Funds page.
3. Click the link for United Kingdom Open-End Funds (AFS). The database opens.

< Note: the database depends on the Local Country you selected under File > Set User
Preferences > Local Country.

Morningstar Direct

File New Favorites Tools Help Search for In Securities - Go
Home -
Equity/Credit Research Welcome, Julie Petitjean-Freytet
Local Databases I Morningstar-defined Universes ~EE
+E8 Flinds/Managed Products Name Size

B Fund Analysis/News/Report All Offshore Open-End Funds 100,621
E Category/Sector Avg IUnited Kingdom Open-End Funds fAFS)I 63,127
H Closed End Funds

E College Saving Flans

B College Saving Portfolios
B Exchange-Traded Funds
H Hedge Funds

B Money Market Funds
E Open End Funds

B European Pension/Life Fund Wrapp
B Insurance and Pension Funds

Be sure to select the
correct page and link

4. From the toolbar above the spreadsheet view, click the Search icon. The Searchby
Criteria window opens.
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Home Open End Funds
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B Money Market Funds [C 7 1167 Act Fds ICAV Glb H IncBd C2 GBP Acc United Kinadom. __ No IEQ0BD6FMO39 Al Lot
[ Open End Funds Morningstar Direct - United Kingdom Open-End Funds (AFS) - O X @
IS European Pension/Life Fi o for
— = = - [ P [
B Insurance and pengion |, BPOPER  JmInsert X Delete  z@ClearAll  f} Export~ BJPDF - fgSave As i Feedback 3
B UK Life and Pension Fund[] | Rl (  Field Name Oparstor valus ) |
- o1
I variable Annuities 4
= variable Annuity Subace([ ] 1 Click here to start a new search b
= variable Life 02 I
= ot
I variable Life Subaccount|[) 3 I
IS Separate Accounts O« |4
E Collective Investment Tr] Os E
= 5
I Models jor
i Unit Investment Trust | © lor
i Private Fund o7 jor
[ Restricted Investors | 8 E
» B8 Stocks Os |4
» & Bonds O 1w v b
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) : Ew"ers B Analyss View Field Name: Include: Items Searched: Ttems Found: Run Search ot
& Economics @By Catagory o T 0 - o
IE Market Indexes [
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ot
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Working with Simple Searches

Exercise 1: Create a search from the Local Databases module

5. Clickin the Field Name cell for the row 1and select Morningstar Category. The
Operator cell in the row 1 defaults to =.

(# Open J=Insert ¥ Delete  z&/Clear All ‘L} Export~ [E] PDF ‘|Save As B Feedback
D Rel { Field Name Operator Value )
O Name
Oz Name
Os -Base Currency
. Virtual Class
- N -ISIN
Os ~Global Broad Category Group
Os :-Global Catego
D 7 ~Maorningstar Category]
Oe ector
~Global Investment Fund Sector (GIFS)
O ~Investment Area
110 Morningstar Rating Overall
~Morningstar Analyst Rating
Vi Field N : . Searched: It Found:
@E‘: C‘et ame Maorningstar Analyst Rating - Process Pillar il e ems Foun Run Search
o EsE=E ~Maorningstar Analyst Rating - Performance Pill
O Alphabetically ~Morningstar Analyst Rating - People Pillar
Morningstar Analyst Rating - Parent Fillar
~Morningstar Analyst Rating - Price Pillar
Help - ~analvst Name = oK Cancel

6. Click the Value cell in the first row. Note that the categories are listed alphabetically.
7. Scroll down and click Europe Large-Cap Value Equity.
8. To preview how many investments meet the criterion, click the Run Search button.

Click to
select a field

Maorningstar Direct -- United Kingdom Open-End Funds (4F5) — m]
@Open =Insert X Delete rZClear Al FExport~ [E|PDF @ (ggSave As i Feedback
| Rel ( Fiald Name Operator value
D 1 Morningstar Category = IEu:c;e Large-Cap Velue Equity
Oz
s
Os
Os
Oz
Os
e
010
View Field Name: Include: Items Searched: Items Found:
(®) By Category Only Surviving Investments o -
() Alphabetically [Juser Defined Brimary Class Only
Help oK Cancel

Note the values
in these fields

Use this button to
see how many items
match the criteria
you have entered
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Working with Simple Searches

Exercise 1: Create a search from the Local Databases module

9. Toview the results of the search in the grid view, click OK. In each row, take note of
what is shown under the Morningstar Category column, and note the Total: number of
investments showing in the bottom-left corner of the grid view.

!4 Mormingstar Dire - u]
le MHew Favorites Tools Help . Search for In This View - Go B Send us feedback |
Home BT e United d Funds (AT
Equity/Credit Research Action* View Snapshot - | Bsave ' search =y edit Data | $sor | @, Locate | £ export~ M PDF | 4 Refresh
Local Databases r Hame - Base Vitual Class 5N Global Braad Global ormimaTiar Cateaory
Corrancy Catagory Group  Catagory
Funds/Managed Products
5 Fund Analysis/News| [~ 1 AAF-Pzena European Equities A € Acc Euro No LUDsasasoas  Equity Europe Equity Large Cap JEAA Fund Europe Large-Cap Valus Equity
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EClosedEndFunds | = 3 aar-pzena European Equities I £ Ace United Kingdom,  No 1313464924 Equity Europe Equity Large Cap  JEAA Fund Europe Large-Cap Value Equity E |. C
B Colers 50076 %01 2 e ewrspeen s 1 2 turo N wosssszraie ety urope Sauity Large oo [EAA Fnd surape Large-ap Value Eaity urope Large-Lap
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S Furopean Pension/L [~ 9 AB European Eq Fif [ Acc Singapore Dollar  Yes LU0289941253  Eauity Europe Equity Large Cap |EAA Fund Eurape Large-Cap Value Equity
H tnsurance and Pens [~ 10 Allanz Europe Equity Value IT EUR Euro No Wil11123391  Eauity Europe Equity Large Cap [EAA Fund Europe Large-Cap Value Eauity
B UK Uife and Pension [~ 11 Allianz Europe Equity Value P EUR Euro No LUIS43696436  Equity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity
I Variable Annuities | [~ 15 llianz Europe Equity Value R EUR Euro o LW1s31926379  Equity Europe Equity Large Cap  [EAA Fund Eurape Large-Cap Value Equity
& varisble Annulty SU = 43 uUND! European Eauity Value FAM KEURASe United Kingdom, ~ Yes [E00BHNMX464  Equity Europe Equity Large Cap  JEAA Fund Europe Large-Cap Value Equity
=i e s [ 16 AMUNDI European Eauiy Value FANKEURAGe  Euro No 1E00BHNMXASS  Equity Europe Equity Large Cap |EAA Fund Europe Large-Cap Value Equty
[ Separate Accounts | | 1 Amundi Fds Europesn £ Val AEUR © Euro No LU1833314244  Equity Europe Equity Large Cap [EAA Fund Europe Large-Cap Value Equity
B Collective nvesime [ 18 Amundi Fos European £q Val 13 GBS C United iGingdom,  No Luzoszzesens  Equity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Value Equity
B Models " 17 Amundi rds European Eq val 33 GBP QD D United Kingdom,  No LuzoszzeTss  Equity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Value Equity
B Unit investment Try [~ 18 AXA Rosenberg Pan-Erup £q Alpha A EURAcE Eure o 1s0008385730  Equity Eurcpe Equity Large Cap  [EAA Fund Eurape Large-Cap Value Equity
E Private Fund [7 15 AXARosenberg Pan-Erup £q Alpha A USDAcc  US Dollar No 1E00807QUSS4  Eauity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity
[ Restricted Investors [~ 20 AXA Rosenberg Pan-Erup £a Alphs B EURAce Euro No IE0004346058  Eauity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Velue Equity
* i stocks [~ 21 B&G Long Term Velue 1 ELR Euro No 1266864385  Equity Eurepe Equity Lorge Cop  [EAA Fund Eurepe Large-Cap Velue Equity
::z:tsm anayzs | [ 22 BAGLong Tem velue R el Eure No Lu1z66865756  Equity Europe Equity Lorge Cop |EAA Fund Europe Large-Cap Value Equity
. B Pt ™23 BA&G Long Term Value 5 GBP United Kingdom,  No LU1266866257  Eauity Europe Equity Lorge Cap | EAA Fund Eurape Large-Cap Value Equity
B Marhet Indexes " 2¢  B&G Long Term Valuel S EUR Euro No LU1266866091  Eauity Europe Equity Large Cap [EAA Fund Europe Large-Cap Value Equity
™25  BGF European Value A2 EUR United Kingdom,  Yes 0171262212 Eauity Europe Equity Large Cap [EAA Fund Europe Large-Cap Value Equity
[T 25 BGF European Value A2 EUR US Dollar Yes LUD171281750  Equity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity
™27 BGF European value A2 EUR Euro o 072462186 Equity Europe Equity Large Cap  [EAA Fund Eurape Large-Cap Value Equity
[~ 28 BGF Europsan valus Ad EUR Eure [ 0162690340 Equity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity
™28 BGF European Valus A1 GEP United Kingdom,  No LU0204052672  Equity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity
™30 BGF European valus D2 United Kingdom,  Yes LupszraTsaze  Equity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Value Equity
M 31 BGF European value D2 US Dollar Yes Lupsz7asan  Equity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Value Equity
< > [ 32 BGF European value D2 Euro o Lu3zesezass  Equity Europe Equity Large Cap  |EAA Fund Europe Large-Cap Value Equity
Global Databases. [T 53 BGF European valus D4 GEP United Kingdom,  No LUDS27879502  Equity Eurape Equity Large Cap [EAA Fund Europe Large-Cap Value Equity
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Portfolio Management ' [ 37 BNP Paribas Europe Value CI D Euro No W0177332450  Eauity Europe Equity Loroe Cap [EAA Fund Eurape Large-Cap Value Equity funds matchi ng
Partfolio Analysis [~ 38  BNP Paribas Europe Value CI D US Dollar Yes W0177332450  Eauity Europe Equity Large Cap [EAA Fund Eurape Large-Cap Value Eauity the search
——— ™39 BNP Paribas Europe Value [ C US Dollar Yes U0177332904  Eauity Europe Equity Large Cap [EAA Fund Europe Large-Cap Value Equity a
— [~ 40 BNP Parbas Europe Value 1 C Euro No 0177332904 Equity Europe Equity Large Cap  [EAA Fund Europe Large-Cap Value Equity parameters IS
— [ 42 BuP Parisas Europe Vakue Prvi € fum o Wo177332730  Equity Europe Equity Large Cap  |EAA Fund Europe Larga-Cap Valus Equ shown here
Rixk Hodel Analysis A 8 c o & e n 3 x L. M N~ o ®» o & s UV W x Yz
Workspace W sebsctsc: 0
MOORMNGETHA* e
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Working with Simple Searches Exercise 2: Save a search

Saving a search precludes you from having to re-enter the criteria again and again for Exercise 2: Save a search

those searches you use frequently. Once saved, a search is found under the Search
Criteria folder from the Workspace tab, or you can open it from the Search window
itself in other modules. To save a search, do the following:

1. You should still be in the Open-End Funds universe, with United Kingdom Open-End
Funds (AFS) showing. From the toolbar above the grid view, click the Search icon.
The Search by Criteria window opens, and the criteria you entered earlier should
still be showing.

Morningstar Direct

File MNew Favorites Tools Help Search for In This View ~ Go
Home I[Jpen End Funds
Equity/Credit Research Action * View Snapshot -+ | | save Click this icon to re-open
Local Databases r TEn= - giffenw the Search by Criteria window

&3 Funds/Managed Products

E Fund Analysis/News [~ 1 AAF-Pzena European Equities A € Acc Euro

H Category/Sector Av [~ 2 AAF-Pzena European Equities I § Acc US Dallar
? Closed End Funds s AAF-Pzena Eurcpean Equities I £ Acc United Kingd
E College Saving Plar a4 AAF-Pzena European Equities I € Acc Euro

B College Saving Port -

— s AAF-Pzena European Equities R § Acc Us Dollar
H Exchange-Traded Fu —

i Hedge Funds e AAF-Pzena Eurcpean Equities R € Acc Euro

H Money Market Fund rz AB European Eq Ptf I Acc Euro

E Open End Funds s AB European Eq Ptf I Acc Us Dollar
E European Pension/L [ 9 AB European Eq Ptf I Acc Singapore D
E Insurance and Pens [ 10 Allianz Europe Equity Value IT EUR Euro

H UK Life and Pension [~ 11 Allianz Europe Equity Walue P EUR Eura

g Variable Annuities [ 1z Allianz Europe Equity Value R EUR Euro

2. From the top of the Search by Criteria window, click the Save Asicon. The Save
As dialogue box opens.

. @B0Open =lInsert ¥ Delete & Clear All ‘L} Export~ [E] PDF % Feedback Click this icon
0O | Rel {  Field Name Operstor value ) to save a search

i - Morningstar Category = Europe Larse—Cap Value Equity [l

Oz

O

D 4

Os

s

O

=

e

1o v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments ] -

() Alphabetically [] user Defined Primary Class Only

Help oK Cancel

<= Note: You could also have clicked Save from the toolbar whilst still in the grid, but the Save As option is only available via the Search by
Criteria window displayed above.
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Working with Simple Searches Exercise 3: Reset a universe after conducting a search

3. In the Name field, type Europe Large-Cap Value Equity.

Save As >
Save As
|
Name " Eurcpe Large-Cap Value Equity ||
l Enter a name for
Existing Searches the search here
oK Cancel Help

4. Click OK to close the dialogue box.

5. Click OK to close the Search by Criteria window. The search you saved can be opened
from the Search by Criteria window, or by going to the Workspace module and selecting
the My Search Criteria page.

Creating the search in Exercise 1 changed the data universe (Open-End Funds) you Exercise 3: Reset a
selected when you began the exercise. Now, instead of seeing all Open-End funds, universe after

you see only Open-End funds in the Europe Large-Cap Value Equity category. You can conducting a search
reset the universe and return to seeing all Open-End funds with one click.

From the toolbar above the spreadsheet view, click the name of the universe, in this
case: United Kingdom Open-End Funds (AFS).

Morningstar Direct

File New Favorites Tools Help Search for In This View * Go
Home Open End Funds I I .
— | . Click here to see
ui redit Research ion~ Vi 5 t - ; == Edi ;
quity, Action~ View Snapsho Bsave i Search [F% Edit Data all investments
Local Databases r Nams= o Vil againin a universe
urrency
&8 Funds/Managed Products
HE Fund Analysis/News [~ 1 AAF-Pzena European Equities A € Acc Euro N
H Category/Sector Ay [™ 2 AAF-Pzena European Equities I § Acc Us Dollar N
? Closed End Funds = AAF-Pzena European Equities I £ Acc United Kingdom, N
E College Sav!ng Plar M a AAF-Pzena European Equities I € Acc Euro M
B College Saving Port
— s AAF-Pzena European Equitiez R $ Acc Us Dollar M
H Exchange-Traded Fu =
E Hedge Funds [} AAF-Pzena Eurcpean Equities R € Acc Euro N
B Money Market Fund 7z AB European Eq Pif I Acc Euro N
= Open End Funds s AB European Eq PH I Acc Us Dollar ¥
E European Pension/L [ 9 AB European Eq Pif I Acc Singapore Dollar g
E Insurance and Pens [~ 10 Allianz Europe Equity Value IT EUR Euro M
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Working with Simple Searches

Exercise 4: Open a saved search

Once saved, a search is found under the My Search Criteria folder in the Workspace
module. Alternatively, you can also open a saved search from the Search by Criteria
window itself anywhere you can access it in another module, such as the Local
Databases module.

To open a saved search from the Local Databases module, do the following:

1. You should still be in the United Kingdom Open-End Funds (AFS) universe. From the
toolbar above the spreadsheet area, click the Search icon. The Search by Criteria
window opens.

2. Click the Open icon. The Open From dialogue box opens.

Exercise 4: Open
a saved search

Morningstar Direct -- United Kingdom Open-End Funds (AFS) -
J=lnsert X Delete &Clear Al A} Export~ [E]PDF : lgqSave As i Feedback
O Rel 4 Field Name Operator value
a: - Click here to start a new search
Oz
sz
(K
s
Oe
az
O
(g
10
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Cstegory Only Surviving Investments 0 -
() Alphabetically [JUser Dafined Primary Class Only
Help oK

Use this icon
to recall a
saved search

Cancel

3. Click Europe Large-Cap Value EQ, then click OK to close the Open From dialogue box.

Open From *
Open From
Existing Searches
Eurcpe Larae-Caop Value EO| -
Be sure to select
the correct search
from this dialogue
hnx
v
oK Cancel

4. Click OK on the Search by Criteria window to execute the search.

Morningstar Direct 2020
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Working with Simple Searches

Exercise 4: Open a saved search

To open a saved search from the Workspace module, do the following:

1. From the left-hand navigation pane, select the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria. If you completed the
exercises in the Working with Investment Lists in Morningstar Direct guide, you will see
the Europe Large-Cap Value Equity search you created and saved as part of that
work. The Europe Large-Cap Value Equity search did not appear in the previous set of
steps (where you opened a saved search from the Local Databases module) because
the Europe Large-Cap Value Equity search considered both Open-End Funds and
Exchange-Traded Funds, and the search in the Local Databases module was looking
only for Open-End Funds. Therefore, searches including other investment types cannot
be seen when opening a search from the Search by Criteria window in the Local
Databases (or Global Databases) module.

3. Double-click the Europe Large-Cap Value Equity item to open it (the second one in
the screenshot below, with Funds (Open-End and Exchange Traded Funds as
universe). Note that the spreadsheet view opens with the results, without first
showing the Search window.

Momingstar Direct

In This View > Go

% Send us feedback

Flle New Favorites Tools Help - Search for

Home

Equity/Credit Research Action~ | New~ | i} Export~ | [K]PDF | % Refresh

Local Databases r Hame Type Owmer Permission Last Updated, Universe

Global Databases
Advanced Searc Julie Petitjean-Freyt Read/Write
Advanced Searc Julie Petitjean-Freyt Read/Write

07/01/2020
07/01/2020

Open End Funds
Funds (Open End and Exchange Traded Funds)

Performance Reporting [ 1 Europe Large-Cap Valus EQ

Asset Allocation ez Europe Large-Cap Value Equity
Portfolio Management

Portfolio Analysis

Markets

Asset Flows

Presentation Studio

Risk Model Analysis

Workspace

~ & Investment Lists
» & My Lists
~&8 Search Criteria
E My Search Criteria

Note the location
where you can find
saved searches in Direct

Morningstar Direct 2020
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Working with Simple Searches Exercise 5: Create a simple search with multiple criteria

Exercise b: Create a
simple search
with multiple criteria

So far, the exercises you have completed have dealt with a search that looked for one
criterion only: Europe Large-Cap Value Equity funds. In practice, your searches will
almost always contain multiple criteria, so let’s explore adding criteria to a search.

When you ran the search for Europe Large-Cap Value Equity funds in Exercise1, you
may have noticed that multiple instances of funds appeared in the results, rather than
just a single instance of each fund. To see only one instance of a fund, you have a
few options. For instance, you could ask to see only a certain share class of a fund,
such as the oldest share class.

For this, we can use a criterion called Oldest Share Class. This finds only the original
share class for each fund included in a search. You will open the search you saved in
Exercise 2 and build on it.

Do the following:

1. Select the Local Databases module and open the United Kingdom Open-End
Funds universe. From the toolbar above the spreadsheet area, click the Search
icon.The Search window opens.

2. Click the Open icon. The Open From dialogue box opens.

Morningstar Direct -- United Kingdom Open-End Funds (AFS) - O X

fOpanl J=Inset X Delete £ Clear All 4 Export~ [E] PDF ' Save As B Feedback ‘ ks it [z
=]

( Field Name Operator value ! to recall a

saved search

O: - Click here to start a new search ~
Oz
Os
|:| 4
s
Os
a-
Os
O
[0 v
View Field Name: Include: Items Searched: Items Found: Run Search
(@) By Category Only Surviving Investments 0 =
() Alphabetically [[]user Defined Primary Class Only

Help oK Cancel
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Working with Simple Searches Exercise 5: Create a simple search with multiple criteria

3. Click Europe Large-Cap Value Equity, then click OK to close the Open From dialogue box.

Open From X
Open From
Existing Searches
Europe Large-Cap Value EQI ~
Be sure to select
the carrect search
from this dialogue
hox
v
oK Cancel
_ |

4. In the Search by Criteria window, click RunSearch, and take note of the number of
items found.

5. Click in the Field Name cell for the second row, and serell down until you can select
Oldest Share Class. The Operator cell in the row 2 defaults to =.

< Note: As soon as you clicked in the Field Name cell for row 2, the word “And” appeared in the
Rel(ationship) column. This means both of these criteria (in rows 1and 2) must be true in order for
a fund to be returned by the search. Also, rather than scrolling down to find a criterion, you could
also have typed the word Old, and the cursor would jump to find Oldest Share Class.

6. Click in the Value cell for row 2 and select Yes.

Mermingstar Direct -- United Kingdom Open-End Funds (AFS) - m] *
. @@0Open  =Insert ¥ Delete & Clear All g Export~ [E|PDF . (gSave As EdFeedback
D Rel { Field Name Operator value ]
d: Maorningstar Category = Eurgpe Lerse—Cop Value Eguity ~
[z |and Oldest Share Class = Yes
0 Note the values
0O« in these fields
s
s
a7
s
(g
1o v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments 63107 18
(O Alphabetically [Juser Defined Primary Class Only
Help oK Cancel

7. Click Run Search again and note the number of funds that are now found.
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Working with Simple Searches

Exercise b: Create a simple search with multiple criteria

8. You now have two criteria in your search for Europe Large-Cap Value Equity funds.
You can re-save the search to reflect this change. Click the Save As icon. The Save

As dialogue box opens.

9. Under the Existing Searches area, double-click Europe Large-Cap Value Equity; this
populates its value in the Name field.

Save As

Save As

Name

Europe Large-Cap Value EQ

Existing Searches

Europe Large-Cap Value EQ

Double-click the
name of an existing
search to override
that item with the
current content

in the Search

by Criteria window

oK Cancel

Help

10. Click OK.

11. When the overwrite confirmation message opens, click OK. Keep the Search by Criteria
window open for the next exercise.
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Working with Simple Searches

Exercise 6: Expand your search to another category

By default, the Search by Criteria window shows you available search criteria by
grouping fields into categories. These categories are identical to the pre-built views
available in the Local Databases grid view. If you know which category (or view) a field
appears in, it is easy to find that field when you want to include it in a search. Some
fields, such as ISIN or Morningstar Rating, appear in more than one search category
(and pre-built view).

So far, the two criteria (Morningstar Category and Oldest Share Class) you have used in
creating searches have appeared in the default Snapshot category, which is expanded
by default when you open the Search by Criteria window. In fact, you might not have
even realised the fields were grouped by category in the Search by Criteria window.
Seeing fields by category is the default setting when working with the Search by
Criteria window.

: & Open J=Insert X Delete z&Clear All ‘L} Export- [E]PDF : (gSave As i Feedback
O Ral Field Name Operator Valus )
|:| 1 - Morningstar Category = Europe Larse—Cap Value Equity
[1z And Oldest Share Class = Yas
Oz and Oldest Share Class
(mE Snapshot ~
Os ‘Sustainability
Operations
Os -MIFID
0- Returns (Daily)
O= Returns (Month-End)
O Returns (Quarter-End)
Ow Returns {Calendar ‘ear)
Dividend (Calendar Year)
View Field Name: Estimated Share Class Net Flow (Month-End) ms Searched: Items Found: Run Search
(®) By Category Estimated Fund-Level Net Flow (Month-End) 07 18
] Iy Risk - Total Return (Month-End)
' Risk - Total Return (Quarter-End)
b Maorningstar Ratings and Grades
UK Standard Asset Allocation
o=l UK Consolidated Asset Allocation oK Cancel
-Equity Sector Exposure
Fouity Industry Fxnosure

Morningstar Direct

File New Favorites Tools Help Search for In This View ~ Go

Home Open End Funds

Action = View

Local Databases r

Equity/Credit Research

- || B zave "y Search [F%

Select Default View... 1

Snapshot

Sustainability
Operations lar
MIFID

~ g2 Funds/Managed Products

E Fund Analysis/News [~ 1 1167

E Category/Sector Av [~ 2 11678 por (Daily) lar
B Closed End Funds | [~ 3 11674 Returns (Month-End) lar
HE College Saving Plar ra 1167 Returns (Quarter-End)

= . Returns (Calendar Year)

E College Saving Port s 1167|4 Dividend (Calendar Year)

E Exchange-Traded Fu re 1167 Estimated Share Class Net Flow (Month-End) Y
E Hedge Funds T ; et B ing
E Money Market Fund rz 1167 |Act Fds ICAV Glb H IncBd C2 GBP Acc Unitel King
= Open End Funds s 1167 Act Fds ICAV GIb H IncBd C3 GBP Inc United King
E European Pension/L. [ 9 1167 Act Fds ICAV Glb H IncBd C5 GBP Inc United King
E Insurance and Pens [~ 10 1167 Act Fds ICAY Glb H IncBd C7 GBP Inc United King

Exercise 6: Expand your
search to another category

The categories here
correspond to the
Vviews in a universe

Note the default
display by which
you find criteria

lew The views here are
reflected in the categary
groupings in the

Search by Criteria window
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Working with Simple Searches Exercise 6: Expand your search to another category

While seeing the Snapshot category expanded by default is convenient for selecting
the most popular fields you may be looking for (which is the intent of the Snapshot
view/category), this category does not allow you to access all of the criteria you might
need for every search. For example, what if you want to eliminate any funds from your
search where the ongoing charges are too high?

To find funds with a lower ongoing charge, do the following:

1. You should have the Search by Criteria window open, with the criteria from the
Europe Large-Cap Value Equity search still displayed. (If not, open the saved search
now, or open the Search from Workspace > My Search Criteria > double-click on
Europe Large-Cap Value EQ (the Open-End Universe) > click Search.)

2. Inrow 3, click in the Field Name cell.

@ Note: Again, the word “And” appears in the Rel column for row 3.

3. Scroll up to the top of the Field Name list and collapse the Snapshet categoryby
clicking once on the icon to the left of its name.

Meorningstar Direct -- United Kingdom Open-End Funds (AFS)

@#Open  =lInsert ¥ Delste ZClearall 4h Export~ [E PDF “q
D Ral i Field Mame O
|:| 1 Morningstar Category =
[12 Aand Oldest Share Class =
13 Aand Name
[« =-Snapshot | ~ ; )

- ~Name Click the icon to the
[ 153
P ..Base Currency left of Snapshot to

- -Virtual Class collapse the category
17 L ISIN
[ 1= ..Global Broad Category Group
e ..Global Category

_Morningstar Catenqory

4. Click the icon to the left of the Operations category to expand it.

Maorningstar Direct - United Kingdom Open-End Funds (AFS)
@ 0Open =Insert X Delete :&Clear Al Export- [EPDF EVEED
|:| Rel { Field Hame Operats
Click the icon to the
Ot - Morningstar Category = left of Operations to
Oz and Oldest Share Class = expand the category
[13 And Name
[mE =-Operations | "
Os ~Name
-Firm Phone
6
g _ ~Firm Web Address
7 Firm Street Address
s ~Firm City
Os ..Firm State or Province
10 ~.Firm Country
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Working with Simple Searches Exercise 6: Expand your search to another category

5. Scroll down in the Operations category and click Management Fee.

Merningstar Direct -- United Kingdem Open-End Funds (AFS) - O Pad
E30pen  Te=lInsert X Delete  zZClear All ‘L} Export~ [& PDF @ Save As i Feedback
O Rel ( Field Name Operatar valus )
|:| 1 Morningstar Category = Europe Large-Cap Value Equity ~
Oz and Oldest Share Class = Yes
13 And Name
0= [=-Operations ~
D 5 -.Name
-Firm Phone i
5 The field appears
Oe Firm Web Address under the "
O- Firm Street Address "
e _Firm City Operatlons category
Os --Firm State or Province
Firm Country
10
U -Firm PostCode =
View Field Name: -Advisor ms Searched: Items Found: Run Search
(®) By Category ..Subadvised -
. -Subadvisor
Alphabeticall
O Al o --Manager-Committee Member
- Closed to New Inv
Closed to Mew Investors Date
Help Max Front Load oK Cancel
_Faze Currency
6. In the Operator cell for row 3, select =<.
7. Inthe Value cell for row 3, type 1.25.
Morningstar Direct -- United Kingdom Open-End Funds (AFS) - O X
@#0Open  =Insert X Delete &Clear All ﬁ Export~ [E]PDF : (gSave As ii Feedback
0 Rel ( Field Name Operator value ]
|:| 1 - Morningstar Category = Europe Large—Cap Value Equitw [l
2 And Oldest Share Class = Yes
Os I.-:‘.nd Management Fee = 125 I Note the values
0+ for this row
[Os
Os
07
Os
e
10 ~
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments 62107 13
() Alphabetically [[Juser Defined Primary Class Cnly
Help oK Cancel

8. Click Run Search. The number of items found now reflects the inclusion of this
additional criterion. Because the Rel(ationship) column for all three rows is “And, " all
three criteria must be true for a fund in order for it to be found by thesearch.

9. Re-save the search again to include this latest change. Click the Save As icon.The
Save As dialogue box opens.

10. Under the Existing Searches area, double-click Europe Large-Cap Value EQ; this
populates its value in the Name field.

11. Click OK to close the Save As dialogue box.

12. When the overwrite confirmation message opens, click OK. Keep the Search by Criteria
window open for the next exercise.
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Working with Simple Searches Exercise 7: Look for a field by name

By default, the Search by Criteria window allows you to select criteria based on the Exercise 7: Look for
category each one is assigned to. This works out fine as long as you know under which a field by name
category each criterion can be found. What happens when you aren’t sure which

category to look in for a criterion? Rather than waste a lot of time expanding, scrolling,

and collapsing categories as you look for a field, you can instead see all criteria listed

alphabetically, regardless of category.

To look for a field by name, do the following:

1. The Search by Criteria window should still be open, with the criteria from the
Europe Large-Cap Value Equity search still displayed. (If not, open the saved
search now.)

2. Inthe bottom-left corner of the Search by Criteria window, select the option

for Alphabetically.
Morningstar Direct -- United Kingdom Open-End Funds (4FS) - O x

@ Open  =Insert X Delete r&’Clear All @ Export~ [E]PDF : (pgSave As i Feedback

i Rrel { | Field Name Operator value )
D 1 - Morningstar Category = Eurcpe Large—Cap Value Equity ~
Oz aAnd Oldest Share Class = Yes
O3 And Management Fee == 1.25
4
Os
Os
[
Os
s
[J1o v

View Field Name: Include: Items Searched: Items Found: Run Search

(_) By Category Only Surviving Investments 62107 1z

[[Juser Definad Primary Class Only

Select this
option to see all
Hele oK Cancel criteria at once

3. Inrow 4, click in the Field Name cell. All criteria are now listed alphabetically.

& Note: Again, the word "And” appears in the Rel column for row 4.

pen 4=Insel ¥ Delete = ear port -~ . bmsave g
: @O =Insert Delete r&Clear Al 4} Ewport- [EIPDF : (ggSave As EEF
|:| Rel { Field Name Operator
|:| 1 --- Morningstar Category =
2 And Oldest Share Class =
3 And Management Fee ==
04 And Management Fee The f|e|d$ all appear in
|:| 5 . Buyers (Institutions) Fs alpzabetlgall ordgr, those
Os & Buyers (Mutual Funds) with symbols an
- _# Buyers (Sep Accts) numbers at the start of
mg % Completely Sold (Institutions) their names appear first
Os .2 Completely Sold (Mutual Funds)
s ..# Completely Sold (Sep Accts)
10 - Investments in Category for 2009
.2 Investments in Category for 2010
View Field Name: & Investments in Category for 2011 ps Searched:
() By Category .2 Investments in Category for 2012 7
(@) Alphabetically .2 Investments in Category for 2013
..# Investments in Category for 2014
% Investments in Category for 2045
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Working with Simple Searches

Exercise 7: Look for a field by name

4. Type Up. You are moved down in the list of criteria and land on
Upside Capture Ratio 1Yr (Mo-End). Click Upside Capture Ratio 1 Yr (Mo-End).

@ 0pen  =Insert X Delete z&/Clear All ‘Q Export- [E] PDF ‘@ Save As EdFeedback

O Rel ( Field Nama Oparatar Value
|:| 1 --- Morningstar Category = t3
12 And Oldest Share Class =
Oz and Management Fee = 1. 25
[14 And Management Fee
Os UK Gilts % (Net) ~
Os UK Gilts % (Short)
0o- -.UK Property % (Long Rescaled)
! ..UK Property % (Long)
Os UK Property % (Net)
Oz UK Property % (Short)
1o UK Reporting Status

UK Reporting Status Date

View Field Name: UK Stancard AA Rescaling Factor (Long) s Searched: Items Found: Run Search As you type the
OBy Category -Umbrella 07 13 name of a
(®) Alphabetically ~Unclassified % (Long Rescaled) criterion, you are
-Unclassified % (Long) moved to that
-Unclassified % (Net) location in the
Help e I ifiad %ok ..—n oK Cancel list of criteri
{Upside Capture Ratio 1 ¥r (Mo-End) ISt Ot criteria
Upside Capture Ratio 1 ¥r (Qtr-End)
5. In the Operator cell for row 4, select >=.
6. Inthe Value field for row 4, enter 100. This line now looks for only those funds achieving
at least 100% of the upside of the market over the past year.
Marningstar Direct -- United Kingdom Open-End Funds (AFS) — O
@ 0pen  G=Insert X Delete zZClear All ﬂ‘ Export~ [E]|PDF : (pSave As i Feedback
0 Rel { | Field Name Operator Value
|:| 1 - Morningstar Category = Equit:
Oz And Oldest Share Class =
3 And Management Fee <=
Oa |.-Z‘.nd Upside Capture Ratio 1 Yr (Mo-End) == 100 Note the values
Os for this row
e
Oz
Os
Os
10
View Field Name: Include: Items Searched: Items Found: Run Search
(C) By Category Only Surviving Investments. 63107 &
©Alphabet\cally D User Defined Primary Class Only
Help oK Cancel

7. Click Run Search.

8. Click the Save As icon. The Save As dialogue box opens.

9. Under the Existing Searches area, double-click Europe Large-Cap Value EQ; this
populates its value in the Name field.

10. Click OK to close the Save As dialogue box.

11. When the overwrite confirmation message opens, click OK.

12. Click OK again to exit the Search by Criteria window.
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Working with Simple Searches Exercise 8: Update your user preferences to find the share class with the lowest management fee

When creating a search to look for only one instance of a fund, you have the
following options:

» You can look for the oldest share class of a fund

» You can look for a specific share class for a fund, such as Institutional or
Retail, or

» You can look for the share class for a fund with the lowest management fee.

The first example has already been explored. The second example is achieved simply by
selecting the Institutional field and choosing the appropriate value (Yes/No). When
conducting a search to look for the share class for a fund with the lowest
management fee, however, you need to first set the proper user preference from the
File menu because no field exists to search on called “Lowest Management Fee.”
Once you set the correct user preference, you can check a special box on the Search
by Criteria window to activate it and make it part of a search.

To create a user preference prioritising the cheapest share class of a fund (over other
share classes), do the following:

1. Onthe menu bar at the top of the Morningstar Direct window, from the File menu, select
Set User Preferences. The Set User Preferences dialogue box opens.

Merningstar Direct
File | New Favorites Tools Help Search for In Securities G

| Set User Preferences ' Select this option
Mew Folder from the File menu

Velcome, Julie Petitjean-Freytet | Tuesday, January 07, 2020

Exit

H Filings
B Excel Add-In Announcements
HE Help/Definitions

E Morningstar Publications

E HFR Research 03/01 2019 Monthly Performance Data Update Schedy
o e s 03/01 2020 Monthly Performance Data Update Schedu
~ & Online Training 30/112  Mormingstar Research Highlights | 2019's Most
B New Users
B Advanced user 18712 Morningstar Research Highlights |Jon Hale's ES
% Events 16/12  Momingstar Direct Release Announcement
E New Enhancements
E Certification More

Exercise 8: Update your user
preferences to find the share

class with the lowest
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Working with Simple Searches Exercise 8: Update your user preferences to find the share class with the lowest management fee

2. Select the User Defined Primary tab.

3. Select the row for Max Management Fee, then click the move to top button. (The
move to top button displays two up arrows.) This ensures this element takes precedence
when conducting a search.

4. Be sure the word Lowest appears in the Cheose column.

Select Institutional and move it to be in 2" position.

6. Be sure the word Institutional Preferred appears in the Choose column.

(Sl

Set User Preferences

General Portfolic Management Import Export Return Settings User Defined Primary™.

User Defined Primary Criteria

After the rules setin the search dialog have been applied, the criteria below will be implemented, in the
order chosen, to select only one share dass per fund provided the 'User Defined Primary’ option is
checked.

If more than one share dass shares the selected preference for the criteria (e.g. more than one share
dass shares the highest management fee and/or the oldest inception date) then all those share dasses
which match the selected preference will be judged using the next criterion (with any share dasses that
do not match the first preference being discarded). If, for the Currency, Distribution or Institutional
criteria, no share dasses for the fund match the preference chosen, then none of the share dasses
should be discarded and so the next criterion is considered.

Order| Criteria in order of preference Choose

1 Max Management Fee Lowest il

2 Institutional Institutional Preferred - | Use the arrows to
3 Performance Star Date Oldest g i)

4 Annual Report Net Expense Ratio Lowest _Iv

5 Minimum Investment Lowest ¥

(] Currency Euro

0 Distribution Status Accumulation Preferred

8 Hedging Policy Unhedged

] Share Class Size (latest) Highest

7. Click OK. In the next exercise, you will learn to leverage this setting.
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Working with Simple Searches Exercise 9: Create a search by criteria in the Workspace module

In this exercise, you will search for those large growth funds (both open-end funds and

Exercise 9: Create

ETFs) meeting the following criteria: a search by criteria in the

>
| 2
>

| 2
>

_ Workspace module
An expense ratio below the category average

Still open to new investors

An above-average Sharpe Ratio for the trailing five-year period, when
compared to their category peers

A Downside Capture Ratio below 100 for the five-year period, and
Have been around for at least five years.

Because you are looking for both open end funds and exchange-traded funds at once,
this search should be created from the Workspace module, where you can look across
both universes simultaneously. Additionally, you will see the following exercise use a
checkbox on the Search by Criteria window that heretofore has not been used.

To create this search in the Workspace module, do the following:

1. In Morningstar Direct, select the Workspace tab.
2. Under the Search Criteria folder, select My Search Criteria.
3. From the toolbar above the grid view, select New > Advanced Search > Funds
(Open-End and Exchange-Traded Funds). The Search by Criteria window opens.
Morningstar Direct
File New Favorites Tools Help Search for In This View * Go B Send U
Home
-
Equity/Credit Research © Action~ || New - I 4k Export~ | [E]PDF | @ Refresh
Local Databases r N Basic Search [ Type Owner Parmission
Global Databases Advanced Search 4 All Managed Investments -
) Select this
Performance Reporting | | 1 Europe Large-Cap Value EQ Analysis/News/Report 4 e
Asset Allocation ez Europe Large-Cap Value Equity Bonds the source for
: Category Average ] the search
Portfolio Management Closed-End Fund
Portfolio Analysis College Savings Flans »
Markets Economic Series
fear oo Exchange Traded Fund
T European Pension/Life Fund Wrappers
: : Funds (Open End and Exchange Traded Funds)
Risk Model Analysis Hedge Fond
| Workspace | HFR Hedge Funds Note the
~E3 Investment Lists eWestment Hedge Funds location
¥ & My Lists Market Index where the
vE5 search Criteria Money Market Fund search should
E My Search Criteria I Open-End Fund be created
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Working with Simple Searches Exercise 9: Create a search by criteria in the Workspace module

4. Setyour criteria as shown in the following table. At the bottom of the Search by Criteria
window, be sure to check the checkbox for User Defined Primary Class Only.

Rel ( | Field Name Operator | Value )
-- Morningstar Category = EAA > Europe
Large-Cap Growth
Equity
And Annual Report Net Expense Ratio < CAT AVG
And Closed to New Inv Not= Yes
closedA Sharpe Ratio 5 Yr (Mo-End) > CAT AVG
nd
And Downside Capture Ratio 5 Yr (Mo-End) < 100
@ Note: Change this date value to the previous month-end period from five years ago. When using
date fields, note that “less than” means “earlier than,” while “greater than” means “later than.”
@ Note: Since we are using the Share Ratio and Downside Ratio pre-calculated statistics for 5

years, our selection will already reflect funds with a 5-year history; therefore, it is not necessary
to add the Inception Date data point backdated to 5 years ago.

ange Traded Funds — m} x

@#0pen  elInsert X Delete £ Clear All @ Export - [E] PDF {{Save As i Feedback
O Ral ( Fizld Name Operator valus )
D 1 Morningstar Category = Europe Larse—Csp Growth Equity ~
Oz |and Annual Report Net Expense Ratio =
3 |and Closed to New Inv Not=
04 |and Sharpe Ratio 5 r (Mo-End) >
Os And Downside Capture Ratio 5 ¥r (Mo-End) <
Os
-
=
Os
1o v
View Field Nama: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments 304554 36
() Alphabetically |4 user D=fined Primary Class only |
Halp oK Cancel

5. Click OK. As you look at the results in the grid view, note that only one instance for each
fund is shown, but a variety of share classes are represented.
6. You may save the search as Europe Large-Cap Growth Equity OF & ETFs.

Be sure your
search reflects the
inputs shown here

Be sure to check
this box as well

Morningstar Direct 2020
© 2020 Morningstar. All Rights Reserved.
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Working with Simple Searches

Final lessons on creating simple searches

A simple search uses the same relationship (namely, “And”) between all rows, no
matter how many criteria are included in the search. The following are some additional
notes to reflect on when creating simple searches:

>

Searches can be created in Marningstar Direct from the Local Databases,
Global Databases, Workspace, Performance Reporting, and other modules,
depending on your needs.

You can select search criteria fields within a pre-built category, or by seeing
them listed alphabetically.

When looking for a field alphabetically, you can type the beginning of its name
to jump to that spot in the list.

For fields that take a numeric value, such as Annual Report Net Expense Ratio,
you can often enter either a number or opt to compare results to the category
average.

Each time you add a criterion to a search, click the Run Search button to
ensure you do not end up with 0 results found. If this happens, it indicates a
parameter of the search needs to be changed.

Searches can be saved, to keep you from having to re-enter the same criteria
over and over again, but remember that the results you see each time you run a
saved search could change.

Saved searches are found under the Workspace module (on the My Search
Criteria page), and these saved search files can be shared with or sent to other
Morningstar Direct users, just as you can with lists.

Use the User Defined Primary preference (available from the File menu) to
include in your searches an additional layer to eliminate all but one type of
share class.

Final lessons on creating simple

searches
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Creating Complex Searches

Overview

Creating Complex Searches

Thus far, the searches you have created have been fairly simple. Although you have
looked for multiple criteria, all of the rows are linked by the “And” relationship. At
times, you may need to create a more sophisticated search where the relationship

between rows is more complicated and you need to leverage additional capabilities of

the Search by Criteria window.
This section covers the following topics:

» Using parentheses within the Search by Criteria window to create
complex searches

» Inserting additional rows into an existing search, and

» Monitoring the relationship between rows as you build a complex
search.

The search you have created so far searches the Europe Large-Cap Value Equity
category for the oldest share class of open-end funds with a management fee below
1.25% and have a 1-year upside capture ratio of at least 100%. What if you want to
see funds matching these criteria, not just in the Europe Large-Cap Value Equity
category, but also in the Large Blend and Large Growth categories? You can do this
by building on the search you have saved, rather than creating three separate
searches.

Do the following:

1. From the left-hand navigation pane, select the Workspace module.

2. Goto My Search Criteria and open the Europe Large-Cap Value EQ search (the Open-
End universe) you created.

3. From the toolbar above the spreadsheet view, click the Search icon. The Searchby
Criteria window opens.

Overview

Exercise 10: Create a search
across multiple Morningstar
categories

@ Open =Insert ¥ Delete £ Clear all 4} Export» [E PDF ‘M Save As B Feedback

0 Rel ( Field Name Operatar Value
|:| 1 Morningstar Category = Cap ol
Oz and Oldest Share Class =
Oz and Management Fee <=
4 And Upside Capture Ratio 1 Yr (Mo-End) w=
s
[de
Oz
=
e
1o w
View Field Name: Include: Items Searchad: Items Found: Run Search

By Category ] Only Surviving Investments =

[v] onl 0

() Alphabetically [Juser Defined Primary Class Only

Help OK Cancel
MmHNlNBS'mH Morningstar Direct 2020
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Creating Complex Searches Exercise 10: Create a search across multiple Morningstar categories

4. You are going to insert a new row. An insertion always goes abave the row you select.
Toinsert a row between rows 1and 2, select the checkbox to the left of row 2.

Maorningstar Direct -- United Kingdem Open-End Funds (AFS) - [m] X
@ Open  =Insert ¥ Delete =& Clear All ‘L} Export~ [E] PDF ‘4 Save As B Feedback
] Rel ( Field Name Operator value )
|:| 1 Morningstar Category = Europe Large—Cap Value Equity ~
):xnd Oldest Share Class = \.'ef_ Check the box
O3 and Management Fee i = 1.25 below the row
14 And Upside Capture Ratio 1 ¥r (Me-End) >= 100 where you want
o to insert a row
s
O
Os
e
[Jio v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments ] -
() Alphabetically [[Juser pefined Primary Class Only
Help oK Cancel
5. From the toolbar, click the Insert icon. A blank row is inserted between rows 1 and 2.
Morningstar Direct -- United Kingdom Open-End Funds (AFS) - O x
& Open X Delete &’ Clear All @ Export~ [E] PDF ‘| Save As EZiFeedback Click this icon to
D Rel { Field Hame Operator value )] inSerT a new row
above the
O: - Morningstar Category = Eurcpe LargeCap Value Equity ~ high”ghted row
Oz
3 And Cldest Share Class =
O« And Management Fee <=
s and Upside Capture Ratio 1 ¥r (Ma-End) == 100
s
a7
[mE:
e
10 v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments ] -
() Alphabetically [[Juser pefined Primary Class Only
Help oK Cancel
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Creating Complex Searches Exercise 10: Create a search across multiple Morningstar categories

6. Innewrow (2), click the Rel column, then select Repeat. The data from the row above is
copied into row 2.

Morningstar Direct -- United Kingdom Open-End Funds (AFS) — O *

. @@Open J=Insert X Delete r&Clear All 4} Export~ [E]POF - (ggSave As i Feedback

O Rel ( | Field Name Operator value )
Oz --- Morningstar Category = Eurcpe Large-Cap Value Equity ~
Oz and
3 |And Oldest Share Class = Yes
O« [Or Management Fee == 1.25
[s [Repeat Upside Capture Ratio 1 Yr (Mo-End) - 100 Choosing
Os Repeat copies
0o~ the contentfrom
O the row above
(R
110 v

View Field Name: Include: Items Searched: Items Found: Run Search

(®) By Category Only Surviving Invastments 0 =

OAIphabeticaHy I:‘ User Defined Primary Class Only

Help oK Cancel

7. The Field Name and Operator cells for row 2 should stay the same. Click the Value cell
for row 2 and select Europe Large-Cap Blend Equity (expand the Europe/Africa/ Asia
section first).

Morningstar Direct -- United Kingdom Open-End Funds (AFS) — [m} X

@ Open Je=lInsert ¥ Delete = Clear All g Export - [E] PDF ‘@ Save As i Feedback

O Ral ( Fizld Nama Oparator value )
|:| 1 Morningstar Category = Europe Lar ~
Oz Cr Morningstar Category = Eurcpe Lar ¥
3 And Oldest Share Class = { Europe Large-Cap Blend Equity ~
|:| 4 And Management Fee == --EUrope Large-Lap (rov quity

- R . . . ..Europe Large-Cap Value Equity "
And Upside Capture Ratio 1 ¥r (Mo-End) >= .
Os P " ¢ : -Eurcpe Mid-Cap Equity When a row is
Os --Europe Small-Cap Equity repeated. you
[k --Eurozone Flex-Cap Equity need to
D a Eurozone Large-Cap Equity change on\y
Eurozone Mid-Cap Equity
9

| ..Eurozone Small-Cap Equity the Value cell
o ..Finland Equity &

View Field Name: Include: Items Searched: ~Fixed Term Bond

(@) By Category Only Surviving Investments 0 ~France Equity _

. ) . ~France Small/Mid-Cap Equity
() Alphabetically [[]user Defined Primary Class Only French PEA Eonia SWAP
GBP Adventurcus Allocation
-GBP Cautious Allocation
Help -.GBP Corporate Bond cel
..GRP Nivarsifiad Rnnd v
< >
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Creating Complex Searches Exercise 10: Create a search across multiple Morningstar categories

8. Repeat steps 6-10 to insert another new row for Europe Large-Cap Growth Equity funds.
9. Click Run Search. The number of funds returned seems unexpectedly high. This
indicates that you need to encapsulate the first three lines of the search in parentheses,
to tell the system to consider them as one object. Otherwise, the system thinks you are
looking for any Europe Large-Cap Value Equity fund, or any Europe Large-Cap Blend
Equity fund, or the oldest share class of Furope Large-Cap Growth Equity funds with an
ongoing charge below 2% with an upside capture ratio of at least 100%.

Morningstar Direct -- United Kingdem Open-End Funds (AFS) - m} x
: @0Open =Insert ¥ Delete & Clear All ﬁj Export» [E]PDF @ (pgSave As i Feedback
O Rel ( Field Name Operator value )
i - Morningstar Category = E Large—Cap Val [l
|:| 2 or Morningstar Category = pe Large-Cap Blend Equity
|:| 3 Or Morningstar Category = Europe Large—Cap &rowth Equity
4  and Oldest Share Class = ¥ This number is
|:| 3 And Management Fee o= 1.25 far hlgher than
e And Upside Capture Ratic 1 ¥r (Mo-End) >= 100 what you should
O expect to see
s for what you
Oe are looking for
1o v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments 52106 927
() Alphabetically [] user Defined Primary Class Only
Help oK Cancel
10. In the ( cell of row 1, type (.
11. In the ) cell of row 3, type).
Marningstar Direct -- United Kingdem Open-End Funds (AFS) — O X
@ 0pen  Telnsert X Delete  =£Clear All ‘L} Export~ [E] PDF ‘@ Save As % Feedback
O Rel (| Field hame Operatar Value )
0L - Mcrningstar Category = Eurcpe 3 ~ Note the
Oz or Morningstar Category = Eurcpe Larse—Cap Blend Eguity inclusion of
Os or Morningstar Category = Europe Large-Cap Grosth Equity E parentheses
4 And Oldest Share Class = Yes
15 And Management Fee <= 1.25
s and Upside Capture Ratio 1 ¥r (Mo-End) == 00
a7
e
Os
1o w
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving [nvestments. 63106 927
() Alphabetically [Juser Defined Primary Class Only
Halp oK Cancal
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Creating Complex Searches Exercise 10: Create a search across multiple Morningstar categories

12. Click Run Search. Note the much lower number of funds returned.
13. Save this search as a new item. Click the Save As icon.
14. In the Name field, type Open-End Large Cap Funds.

Save As x
Save As
Name || Open-End Large Cap Funds| || Note the name
- for the new search
Existing Searches Europe Large-Cap Value EQ
OF. Cancel Help

15. Click OK to close the Save As dialogue box.
16. Click OK to close the Search by Criteria window.
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Creating Complex Searches Exercise 11: Create two searches at once

In the last exercise, you saw how to use a set of parentheses to encapsulate a single Exercise 11: Create two

set of criteria. What if you need to look for two separate sets of data at once? For searches at once
example, imagine you have been asked to find value-oriented funds with a P/E ratio of

no more than 17, and growth-oriented funds that have a P/E ratio of at least 177 This

type of search requires multiple instances of parentheses. To create two searches at

once, do the following:

1. From the left-hand navigation pane, click the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria.

3. From the toolbar above the grid view, select New > Advanced Search > Funds (Open-
End and Exchange Traded Funds). The Search by Criteria window opens.

Marmningstar Direct

File MNew Favorites Tools Help Search for In This View - Ga % Send us feedback

Home

——

Equity/Credit Research Action ~ | New - I @ Export~ | [E] PDF @ Refresh

Local Databases r Basic Search + - Type Ovmer Parmizs4

Global Databases Advanced Search  » All Managed Investments

Performance Reporting i Europe Large-Cap Growth Equl Analysis/News/Report ¥ Bn-Freyt Read/

Asset Allocation ez Europe Large-Cap Value EQ Bonds n-Freyt Read/

) 3 Europe Large-Cap Value Equit Category Average » &n-Freyt Read/'
Portfolic Management .
Ma Open-End Large Cap Funds Closed-End Fund n-Freyt Read/ Select this

Portfolio Analysis College Savings Plans 3 universe
Markets Economic Series to search within
Asset Elows Ewxchange Traded Fund

European Pension/Life Fund Wrappers
Funds (Open End and Exchange Traded Funds)

Presentation Studio

Risk Model Analysis

Hedge Fund

Workspace HFR. Hedge Funds
~&8 Investment Lists eVestment Hedge Funds

» B2 My Lists Market Index
+E5 Search Criteria Money Market Fund

Open-End Fund Note the
¥ B8 Report Templates Ownership-Portfolio location

E Chart Templates Ownership-Security where the

» & Data Sets Pension/Life/Insurance » search should
» & Custom Database Private Funds be created

E Defined Contribution Plai

E Saved Reports Global Restricted Funds

E Note Manager Separate Accounts
E Retirement Plans Ceollective Investment Trusts
» &5 Group Manager Models

eVestment Separate Accounts
Stock
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Creating Complex Searches

Exercise 11: Create two searches at once

4. Create a search with the following criteria:

< Note: Remember to use the Repeat option from the Rel column to avoid having to select the
same field name multiple times. Selecting the Alphabetically button in the lower-left corner of

the dialogue box can help find the criteria more quickly.

Rel | ( | Field Name Operator | Value )

- (| Morningstar Category | = EAA > Eurozone Large-Cap Equity

Or Morningstar Category | = EAA > Eurozone Mid-Cap Equity

Or Morningstar Category | = EAA > Eurozone Small-Cap Equity )

And P/E Ratio TTM (Long) <= 17

Or ( | Morningstar Category | = EAA > Eurozone Large-Cap Equity

Or Morningstar Category | = EAA > Eurozone Mid-Cap Equity

Or Morningstar Category | = EAA > Eurozone Small-Cap Equity )

And P/E Ratio (TTM) (Long) | > 17

And Oldest Share Class = Yes

Jornings T - O
@ Open  =Insert X Delste &' Clear All @ Export~ [E] PDF ‘M Save As B Feedback
O Ral ( Fiald Name Operator Value ]
Your Search

O - ( Morningstar Category = ~ b\/ Criteria
Oz or Morningstar Category = WindOW
Oz or Maorningstar Category = ) should reflect
[+ &nd F/E Ratio (TTM) (Long) == this image
s or ( Morningstar Category =
|:| [ Or Morningstar Category =
|:| 7 Oor Morningstar Category = )]
s and P/E Ratio (TTM) (Long) >
(g
o v

View Field Nama: Include: Items Saarched: Items Found: Run Search

(®) By Category Only Surviving Investments 304522

() Alphabetically I User Defined Primary Class Only

Halp oK Cancal

5. Click the Run Search button, to see how many funds match your search.
6. Activate the User Defined Primary Class Only option.
7. Click the Save As icon. The Save As dialogue box opens.

8. Inthe Name field, type Multiple Searches.
9. Click OK to close the Save As dialogue box.
10. Click OK to close the Search by Criteria window.

< Note: The User Defined Primary Class Only option is not taken into account by the Run Search function. To know the true number of
resulting investments, check the battom left corner of the grid window to see the Total number of investments.

@ Note: In the search results (seen in the grid view), you can check your work by sorting on the
Morningstar Category column (click once on a column'’s header to sort by that column), and also
by examining the P/E Ratio (TTM) (Long) statistic, which is available from the Equity Port Stats
(Long) view.

Morningstar Direct 2020
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Creating Complex Searches Final lessons on creating advanced searches

An advanced search uses relationships (And, Or) between rows, and can also include  Final lessons on creating
the use of parentheses. When creating advanced searches, keep in mind the following ~ advanced searches
additional notes:

» When you have the same Field Name for multiple consecutive rows, but a
different Value, encapsulate the rows with parentheses, and use “Or” as the
Rel(ationship) among them. In the row for the next criterion, remember to
change the Rel column to “And.”

» Selecting “Repeat” from the Rel column is an easy way to copy data from the
row above and saves you a few clicks from making a selection for every cell
inarow.

» You can nest criteria in multiple levels through the proper use of both
parentheses and the relationship between rows.

» You can insert rows in the Search by Criteria window; remember that the
inserted row appears above the row you have selected.
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Additional Practice Exercises

Overview

Additional Practice Exercises

The following exercises provide challenges for you to see how well you can build
searches within Morningstar Direct. Answers to each exercise are provided on the
following pages.

How many passively managed Open-End funds and ETFs in the Europe Mid-Cap Equity
category are for sale in the United Kingdom? Only one instance of each fund needs to
be shown. What should the Search by Criteria window look like for this search? The
following hints will help you with this exercise:

1. Create the search from the Workspace module.

2. Search within the Funds (Open End and Exchange-Traded Funds) universe.

3. Use the Europe/Africa/Asia category classification.

4. Opt to see the criteria listed alphabetically and look for a field called “Index Fund.”

Now check your work: Solution to Exercise 12.

Overview

Exercise 12: Find passively
managed funds in a
Morningstar Category
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Additional Practice Exercises Exercise 13: Find ESG funds

How many global emerging markets equity Open-End funds have at least 4 Exercise 13: Find ESG funds
globes, a low carbon designation from Morningstar, and don't invest in
tobacco companies? Please display only the oldest share class per fund.

The following hints will help you with this exercise:

1. The search can be created using the Open-End funds universe from Workspace
> Search Criteria.

2. When looking for global emerging markets equity funds, be sure to select
Morningstar Category as the Field Name and to use the Europe/Africa/Asia
classification.

3. You can find all ESG-related data points under the Sustainability drop-down list.

Now check your work: Solution to Exercise 13.

MmHN'NBS'mH Morningstar Direct 2020 39
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Additional Practice Exercises

Solution to Exercise 12

For Exercise 12, the Search by Criteria window should look like the following:

Solution to Exercise 12

D T - 0O Be sure to
{ @0pen  T=Insert X Delete  Z’Clear All g Export~ [E]PDF @ (gSave As i Feedback Seal’Ch_Wlthln
. — : this universe
O Rel ( Field Name Operator value )
from the
— = Waorkspace
1t Maorningstar Category = Burcpe Mid-Cap Equity module
[z |and Country Available for Sale = United Kingdem
3 |and Oldest Share Class = Yes
14 |And Index Fund = Yes
s
s
a7
Os
e
O v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments 204565 5
() Alphabetically [[Juser Defined Primary Class Cnly
Help oK Cancel
To reproduce this search, do the following:
1. From the left-hand navigation pane, click the Workspace module.
2. Under the Search Criteria folder, select My Search Criteria.
3. From the toolbar above the grid view, select New > Advanced Search > Funds
(Open End and Exchange-Traded Funds). The Search by Criteria window opens.
Morningstar Direct
File MNew Favorites Tools Help Search for In This View -~ Go B Ser
Home
Equity/Credit Research . Action .| New ~ I 4} Export~ | [(EIPDF | 4 Refresh
Local Databases r N Basic Search » Type Owner
Global Databases Advanced Search r All Managed Investments
Performance Reporting i Europe Large-Cap Growth Equ Analysis/News/Report 4
Asset Allocation 2 Eurocpe Large-Cap Value EQ Bonds
- M= Europe Large-Cap Value Equity Category Average 3
Portfolio Management ra Muttiple Searches Closed-End Fund
Portfolio Analysis s Open-End Large Cap Funds College Savings Plans 4
Markets Economic Series
Asset Flows Exchange Traded Fund
e — European Pension/Life Fund Wrappers
: : Funds (Open End and Exchange Traded Funds)
Risk Model Analysis Hedge Fund
Workspace HFR. Hedge Funds Select this
B8 Investment Lists eVestment Hedge Funds universe

~E5 My Lists
H Other
E Workshop
=& Search Criteria
b &5 My Search Criteria
» &3 Report Templates
E Chart Templates
» &5 Data Sets
» &8 Custom Database
E Defined Contribution Plai
E Saved Reports
E Note Manager
E Retirement Plans
» &8 Group Manager

Market Index

Money Market Fund
Cpen-End Fund
Ownership-Portfolio
Ownership-Security
Pension/Life/Insurance
Private Funds

Global Restricted Funds
Separate Accounts
Collective Investment Trusts
Models

eVestment Separate Accounts
Stock

to search within
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Additional Practice Exercises

Solution to Exercise 12

4. Create a search with the following criteria:

= Note: Selecting the Alphabetically button in the lower-left corner of the dialogue box can help
find the criteria more quickly.

Rel | Field Name Operator | Value
Morningstar Category = EAA > Europe Mid-Cap Equity
And Index Fund = Yes
And | Oldest Share Class = Yes
And | Country Available for Sale | = United Kingdom

< Note: the order of the data criteria selected does not matter in this exercise.

5. Click OK.

MORNINGSTAR
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Additional Practice Exercises

Solution to Exercise 13

The search you created for exercise 13 should look like the following:

Solution to Exercise 13

Morningstar Direct -- Open End Funds

(®) By Category
() Alphabetically

Help

D Rel { Field Name
It Marningstar Category
[z and Morningstar Sustainability Rating
O3 and Low Carbon Designation
2+ And Product Involvement % - Tobacco
s and Oldest Share Class
s
[
=
e
1o
View Field Name: Include:

Only Surviving Investments

[[Juser pefinad Primary Class Only

@ 0pen  =Insert ¥ Delete =&’ Clear all @ Export~ [E PDF ‘P Save As i Feedback

Operator Value

= ¢lobal Emerging Markets Equity

= Above Average

Items Searched: Items Found:
287260 28

Cancel

To see these same results, do the following:

1. In the left-hand navigation pane, select the Workspace module.
2. Click New > Advanced Search > Open-End Funds.
3. Under the Morningstar-defined Universes list, click the

United States Separate Accounts/CITs universe.

Morningstar Direct

In This View v Go ¢ sen

Global Databases

Performance Reporting i

Asset Allocation re
s
Portfolio Management
4
Portfolio Analysis rs

Markets

Asset Flows
Presentation Studio
| Risk Model Analysis
Workspace

~ &8 Investment Lists
~E8 My Lists
= Other
B Workshop
~E5 Search Criteria

» &2 Report Templates
E Chart Templates
» 8 Data Sets
» &8 Custom Database
H Defined Contribution Plar
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Additional Practice Exercises Solution to Exercise 13

4. From the toolbar above the grid view, click the Search icon. The Search by Criteria
window opens.
5. Create a search with the following criteria:

Rel | ( | Field Name Operator Value )
- Morningstar Category = EAA > Global Emerging
Markets Equity
And Oldest Share Class = Yes
And Morningstar Sustainability Rating | >= Above Average
And Low Carbon Designation = Yes
And Product Involvement % —Tobacco | = 0
@ Open TelInsert X Delete & Clear All g Export - [&] PDF ‘M Save A= i Feedback
O Rel ( Field Name Operator value ]
D 1 --- Morningstar Category = ©lobal Emerging Markets Equity ~
Oz and Oldest Share Class = Yes
Os= And Morningstar Sustainability Rating = Above Average
14 And Low Carbon Designation = Yes
Os and Product Involvement % - Tobacco = 0
e
Oz
s
e
1o v
View Field Name: Include: Items Searched: Items Found: Run Search
(®) By Category Only Surviving Investments ] -
OAIphabetically I:‘ User Defined Primary Class Only
Help oK Cancel

6. Click Run Search to preview the number of investments that met the search criteria.
7. Click OK to view the investments that meet the search criteria.
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